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EASY-ROB™ Operation References 

PlugIn Dlls 

AVI - Recorder 

 

In the current version of EASY-ROB™ you can directly create AVI video files. There's no external software 
needed for video capturing.  
 

1. Load the cell  (*.cel)  
2. Open the panel either by using the menu   

View | EASY-ROB PlugIn Dlls | AVI Recorder or use the button: 

  
 
Alternative: Push the “F6” Button 
 

 
 

 Select window-size  Show Recording 

 Select a path where to save the file 
 

Select: Number of frames 

 Pause Recording  Start Simulation 

 Stop Recording  Abort Simulation 

 

 
 

 
First you have to select if you want to capture the 
recording with or without the toolbar and status line. 
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AVI Recorder 
 

 

 
 

 
 

With a click on “Setting” you can select a window 
size 

. 
 

 

 

 
 

 
 

 
With a click on„Initialize“ you can set the name of the 

file and a place where to save it 
. 

 

 

 
 

 
 

 
 
 

After that you can set the Framerate (fps) and the 
Simulation-Stepsize (ms) 

 
 

 

 
 

 
 
 

Selecting the compressing factor is the last step 
before you can start a recording.  

 
 

 

 
 

 
 

With a click on „Rec“ you can start the recording 
 

A click on “RUN” starts the simulation. 

 

 
 

 
 

After the recording you can show the recorded AVI 
by using the „Show“ button 
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EASY-ROB™ Operation References 

PlugIn Dlls 

VRML Export with Animation 

 

 
If you want to exchange the work cell (static) or the result of the simulation (with animation) you can use the 
VRML 97 Export to store the whole work cell including the animations sequence into a file with extension 
(*.wrl). 
 
 

1. Load the work cell „three_robots.cel“ 
2. Open the panel by menu:  

View | EASY-ROB PlugIn Dlls | VRML 97 Export 
Alternative: Push the “F7”-Button 

 
 

 
Export static: 

 

 
 

 
 
 

To export a static workcell click on „Export“ and save 
the VRML-file.  

 
 

To see the workcell in the explorer just click „Show“. 

 
Export dynamic: 

 

 
 
 
 

 
To export a workcell including the animation click on 

„Start“ to record and start the simulation.  
At the end of the simulation Stop the recording with 

„Stop“ and save the VRML-file. 
 
 

To see the animation in the explorer just click „Show  
 
 

Remark: Prerequisite for an animation is a loaded 
and running program. 
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EASY-ROB™ Operation References 

PlugIn Dlls 

Path planning with AutoPathTM 

 

 
To engineer a workpiece into the fixture or to move around an interfering geometry is a time-consuming 
task. 
 
The EASY-ROB™ option AutoPath™ will support the user to plan and create collision free paths. 
 
 
The example below will show the capability and the functionality of AutoPath™. 
 

 
1. 
Load the workcell 
 
AutoPath_Example_01.cel 
 
with the button Load from Library 
from the directory:   
 
../EASY-ROB / ApplicationLib / 
 

 
 

 
 
Start Device Manager 
Shortcut: „Ctrl+Shift+O“ 
 
 

 
Annotation: 
 
The example demonstrates a typical initial situation and the result of a collision free path planning done by 
AutoPath™. 
 
The workpiece has to go through the frame and has to be placed on the other side of the frame. 
 
The first cycle shows the shortest way from start to the target – of course including collision. 
 
The path in the second cycle was planed by AutoPath™ and is collision free. While planning a path, 
AutoPath™ is taken the axis limits of the robot into consideration. 
 
An additional geometry on the way through the frame requires a further optimization of the path. 
  
In the last cycle the workpiece is moving along the optimized path. 
 

 
2. 
Start the simulation with the button 
Run Program 
 
 

 
 

 
 
Shortcut: „Ctrl+R“ 
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Introduction of the AutoPath™ example 
 

 
Commentary of the single steps of the program: 
 

 
3. 
Open the Teach Window by mouse 
click on the button Open Program 
Teach Window to see the current 
program 
 

 
 

 
 
 

 
4. 
After the declaration of the variables 
and the settings for the collision 
detection the robot will move by PTP-
commands (line 26) from the start 
position to the target position. 
 

 
 
 
 
 
 
 
 
 
 

 

 
5. 
The second cycle was planed by 
AutoPath™. The collision free 
positions are placed for a better 
overview into a sub function (fct 
ComputedMotion(), line 59). 
 
The base for path planning is a 
collision free start and target position 
(2 tagpoints). 
The calculated collision free positions 
in between will be stored as axis 
values  
(including start and target position)  
 
The determined positions for the 
move forward can be used in reverse 
order for the way back. 
 

 
 
 

 

 
 
 

 
6.  
After the second cycle geometry will 
be set to visible. 
(line 48) 
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Introduction of the AutoPath™ example 
 

 
7. 
The path is not collision free anymore 
and requires a further optimization. 
 
 

 
 
 

 

 
 

 
8. 
By using AutoPath™ the path was 
optimized and stored in the function 
„call 
ComputedMotion_with_Disturbance 
()“. 
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EASY-ROB™ Operation References 

PlugIn Dlls 

Path planning with AutoPathTM – Dialog and Operation  
 

 
1. 
Start the AutoPath™ dialog from the menu 
 
View | EASY-ROB PlugIn Dlls | AutoPath 
Motion Planner 
 
 
 
 
 
 

 

 
 

 
2. 
The dialog AutoPath™ and the most 
important elements: 
 

1. Set start pose 
(to set the collision free start 
position, without exceeding 
the axis limits of the robot) 
 

2. Set end pose 
(to set the collision free end 
position, without exceeding 
the axis limits of the robot) 
 

3. Find path 
(search a collision free path 
from start to the target 
position) 
 
 
The calculation can take 
several minutes – depending 
on the complexity of the 
situation and the computer 
performance. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 
 
2 
 
3 
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AutoPath™ Dialog and Operation 
 

 
3. 
Open the Tag Window by double click on the 
button Sel Tag 
 
(workcell AutoPath_Example_01.cel)  
 

 
 

 

 
4. 
Select with „sel Pth“ the path „Rob“ and move 
the robot to tagpoint R_1 (double click the 
tagpoint in the list of the TagWindow ) 

 
 

 
 
 
 
 
 
 
 

 

 
5. 
Click the button „Set start pose“ in the motion 
planner to set the tagpoint R_1 as start 
position. 

 
 

 
 
 
 
 
 
 

 

 
6. 
Select with „sel Pth“ the path „Frame“ and 
move the robot to tagpoint F_1 (double click 
the tagpoint in the list of the TagWindow ) 

 
 
 
 
 
 
 
 
 

 
7. 
Click the button „Set end pose“ in the motion 
planner to set the tagpoint F_1 as end 
position. 
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AutoPath™ Dialog and Operation 
 

 
8. 
Leave all settings to default and click „Find 
path“ in the AutoPath™ dialog to calculate a 
collision free path. 
 
 

 
 
 
 
 
 
 
 

 

 
Important Note: 
The process to calculate a collision free path can take up to several minutes – please don’t lose the 
patience and don’t start any other EASY-ROB™ functions while the calculation. 
 

 
9. 
After the search the collision free path will be 
displayed as single positions. 
 
Move along the positions by clicking on 
“Run”. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Subject to change or improve without prior notice 13/33 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Phone: +49 6192 921 70-77  FAX: +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

EASY-ROB™ Operation References 

CAD Import  

Import VRML with Animation 

 

 
All common 3D-CAD systems such as Catia, ProEngineer, Solid Works, Solid Edge, etc are able to export 
VRML 1.0 and VRML 2.0. 
EASY-ROB™ can import VRML files and save them as IGP-Files (*.igp). The Import does not include 
kinematics or animations in the VRML-file. 
 
Additionally to the  *.igp-file the importer will create automatically a *.rob-file. 
 
Even when the files from different systems are all VRML-files, with regard to the inner structure (number of 
objects and number of polygons) they are all different. 
Solid Edge, UGS e.g. is using. „Shapes“ to set colors and objects. 
 
EASY-ROB™ is taking this into consideration while import by using a presetting and the functionality to 
“merge”  the polygons. 
The „merger“ will reduce the number of objects and will increase the number of polygons per object. 
And even when the file that the merger is creating will be bigger as the „not-merged“ file, you will have a 
better performance . 
  
In the  „VRML-Examples“-folder you will find examples from different systems with some remarks about the 
presetting. 
 
TIP: Always use the „Merger“, so you will have a better performance while rendering. 
 
VRML files are ASCII-files. You can open and read them in every editor. 
Most times you will find additional information in the header of the file. 
  
TIP: Before the import always save your work and start a new session of EASY-ROB. 
 
To load a VRML file you can either 

1. select the file by menu  File | Load | Import / Convert | Convert VRML1.0 /2.0 into CAD Preview  
or 

2. use „Drag’n Drop“ from Explorer  
 

 

 
 

 
Beside the Message Window you will get the dialog 

for the Converter Settings 
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CAD Import - VRML 

 

 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 

 
By the CAD Presetting you can configure the 

exporting system. 
 

This is important because depending on the 
export system EASY-ROB has to use different 

options for the import 
 

TIP: 
 
Always use the presetting. 
Changing the presetting can cause bad system 
performance. 
 

 
 
 
 
 
 
 
 
 

With the Warning level you decide how much 
information you will get while the 

import. 
Silent = Standard messages 

Warning = only warnings 
Verbose = detailed 

 
 
 

With Start Conversion 
you can start the converter 

 
 
 
 

In the Message Window you can follow all 
messages and by using the „Save“-button you can 

store the protocol of the import 
 
 

TIP: 
 
Double click onto a line with bracket will open 
the file in the editor 
Double click onto any other line will delete the 
whole Message Windows 

 

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Subject to change or improve without prior notice 15/33 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Phone: +49 6192 921 70-77  FAX: +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

CAD Import- VRML 
  

 
EXTRA for the import from Pro Engineer 
 

 

 
 

 
While reading parts from Pro Engineer you are able 
to reduce the data by using the LOD (Level of Detail) 
 
By using this option you can reduce the data-volume 
and increase the system performance. 
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EASY-ROB™ Operation References 

CAD Import 

CAD2ER - Converting STEP- and VRML II 97-files to IGP 

 
  

 
EASY-ROB™ - CAD2ER allows to convert STEP- and VRML II,97 files to IGP. 
You can find the application as standalone program in subfolder ./cad2er/ of the EASY-ROB™ -Application. 
Loaded Rob- und IGP- files will be loaded in a new EASY-ROB™ Session. 
 
Start CAD2ER with the shortcut „Ctrl+Shift+C“ or by Menu: Load > Start CAD2ER Converter 
 

 
CAD2ER was developed in collaboration with machineering GmbH & Co. KG (www.machineering.de). 

 
Handling 

• Select the file you want to convert by clicking on  . 

• Change  the name of the file into „Output File“ 

• Place a checkmark on „User Color“ to configure the colour. 

• Click on  the begin the conversion of the file. 

• Double-click on the generated file-name in „[]“ brackets to open the file in a new EASY-ROB-
session. 

• Quit CAD2ER by clicking on  
 

TIP: Native CAD-files, like CATIA V4/V5 or Pro/Engineer can be converted to STEP by using the 
software „3D-Tool”. 

 

mailto:info@easy-rob.com
http://www.easy-rob.com/
http://www.machineering.de/


 

Subject to change or improve without prior notice 17/33 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Phone: +49 6192 921 70-77  FAX: +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

EASY-ROB™ Operation References 

CAD Export 

CAD-file Export 
 

 
Single robots or devices or even the complete workcells can be exported as binary STL-files. STL binary is 
a neutral format and can be imported in all common CAD-Systems. Furthermore the results of the planer 
can be analyzed by the user. 
  
Optional: the exported STL-file can also include colours, though it is not supported by every CAD-system. 

 

 
Workcell: arcweld_L_01.cel 
 

To export a robot select a robot by click on  
Menu: File > Save > Export > STL binary, 
to open the CAD Export Window  
 

 
 

Selecting „cDevice with childs“ exports the robot 
with the Welding-Torch as coloured STL-file e.g.. 
„cDeviceChilds_stl“. 
 

   
Robot as STL binary file Rotary table als IGP binary file 
 
 
 
 
 
 
 
 

To export the rotary tabel „POSITIONER_01“ with 
the component „WORKPIECE_02 „ to a IGP 
binary-file, the rotary table has to be selected first. 
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CAD-file Export 
 

 

 
Workcell as VRML II,97 file 
 

 
 
 
IGP binary-file decreases file-size to nearly 50%. 
Import will happen 20% more faster. All 
geometries will be saved in world-coordinates. 
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EASY-ROB™ Operation References 

Project Manager 

Administrate Projects 

 

 
The Project Manager provides different functionalities to administrate EASY-ROB™ workcells and project 
related information. The search functions are supporting the user to find the desired data straight away. 
The project data can be stored either by using the input mask in the Project Manager or by the Visual File 
Interface out of EASY-ROB™ (see chapter „Visual File Interface“) 
Further on the Project Manager is able to run and show videos of the workcells and is able to load the 
workcell straight into the EASY-ROB™. 
 

 
Start the Project Manager by double click onto the executable „/EASY-ROB/easyrob-project-manager.exe“ 
or from EASY-ROB™ by shortcut „Ctrl+Shift+P“ . Or use  the menu :File Menu: Load -> Start Project 
Manager. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

screenshot / 
video screen 

start EASY-ROB™ and load 
workcell 

detailed information of project  

project overview 

project modification  

video controls 

search function 
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Project Manager 
 

 
 
 

 
Add a new projects 

 
 
 

 

 
Modify an existing projects 

 
 
 

 

 
Delete a projects 
 

 

 
 

 
Quick Search 
 
Options for Quick Search: 

- Enter a complete word 
- Enter a part of a word 
- Enter numbers 

 
Tip: 
Using an empty field and „Refresh“ will show all 
items of the database. 
 

 
 
 

 

 
Extended Search with filter 

 
 
 
 
 
 
 
 

 

 
Export all projects into an EXCEL file 

 
 

 
 
 
 

 
Controls for the video 
 
(if the buttons are disabled there is no video) 
 

 

 
 
 
 

 
Start EASY-ROB™ and load the selected 
workcell 
 
(if the button is disabled there is now workcell) 
 

  

mailto:info@easy-rob.com
http://www.easy-rob.com/


 

Subject to change or improve without prior notice 21/33 

  
EASY-ROB Software GmbH  Hauptstr.42  65719 Hofheim am Taunus  Germany  Phone: +49 6192 921 70-77  FAX: +49 6192 921 70-66  info.er@easy-rob.com  www.easy-rob.com 
 

EASY-ROB™ Operation References 

History Diagram 

Visual analyses of the simulation 

 

 
The functionality „History Diagram“ enables the user to analyze the simulation visual by a graphic. 
 
History Diagram can record the state of every device into the workcell. The state like e.g. „waiting for signal“ 
or an „axis limit exceeding“ will be stored while every simulation step and be displayed and analyzed in a 
diagram. 
Because all possible states will be shown in different colors, an occurring error can be identified 
immediately. 
 

 
Start the History Diagram by double click onto the executable „/EASY-ROB/easyrob-history-diagram.exe“ or 
from EASY-ROB™ by shortcut „Ctrl+Shift+H“. To start from the menu use “File Menu: Load -> Start History 
Diagram.” 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Detail settings  Data 
handling 

Graphic of the simulation 

Zoom 
function 

Time 
scale 

Show,  
Save data 
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History Diagram 
 

 
 
 
 
 
 
 

 

 
Load, reload and unload history file 

 
 
 
 
 
 
 

 

 
Zoom in and out the view and reset to start 
conditions 
 
(zoom is only related to the lenght of the 
diagram, not to hight) 
 

 

 
 

 
Show time scale 
 

- every second 
- 10 seconds  
- every minute  
- switch scale off 

 

 
 
 

 

 
Reset time to start conditions 

 
 
 
 
 

 
Start and end time of the displayed area 

 
 
 
 
 

 
Rough display :all errors in one color  
detailed display: every error in its own color 
 

 
 
 
 

 
Selection of the displayed Device  
(all or one Device) 

 
 
 
 
 
 
 
 
 

 
Show: 
Show the diagram (with the selected settings) 
 
Save: 
Save the diagram as JPG-picture in the same 
directory of the history file 
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EASY-ROB™ Operation References 

ERC Command Searcher 

Search ERC Commands  

 

 
The example library contains for each ERPL-/ERCL- command a workcell with program. 
The ERC Command Searcher will support the user to search for a specific ERC commands in the example 
library “Proj_example_erpl”, which is normally installed in the directory: 
“.\EASY-ROB\Tutorial\Proj_example_erpl” 
 
The library contains many short example programs with different ERC commands to give an impression 
how the commands are working 
 

 
Start the ERC Command Searcher by double click onto the executable „/EASY-ROB/ easyrob-erc-
command-searcher.exe“ or from EASY-ROB™ by shortcut „Ctrl+Shift+S“. From the menu use „File Menu: 
Load -> Start ERC Searcher“. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
  

enter search word / pre-select  

load workcell  

open program  

instruction manual 

change paths  

results of the search 

start search  

start simulation straight 
after loading  
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EASY-ROB™ Operation References 

3D-PDF-Export 

Saving simulation process in 3D-PDF document  

 
 

 
The new EASY-ROB™ 3D-PDF Export option allows to save entire simulation process of a work cell in one 

3D-PDF document. Afterwards it can be opened, using the free Adobe® Reader XI and the whole simulation 

can be started. 

  
 

To ensure a proper operation, we recommend using at least version XI (11.0.10) of Adobe® Reader. 

 

The 3D-PDF Export can be found under View > EASY-ROB PlugIn Dlls > 3D-PDF Export. 

 

 
3D-PDF Export dialogue 

▪ Open the 3D-PDF Export dialogue  

▪ Click on Start to begin recording. 

▪ Start the simulation. The simulation run will be 

recorded. The number of recorded frames will be 

displayed. 

▪ Click on Stop to finish the recording. You will be 

asked to enter the destination directory and the 

name of the 3D-PDF document. 

▪ The 3D-PDF document will be created. 

 

 
The Adobe® Reader allows to rotate and zoom the recorded scene. 

3D-PDF Export 
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3D-PDF-Export  
 

Use the navigation bar to start, pause or stop the recorded simulation process. Fast forward and rewind 

(x1/64 – x64x speed) are also possible. The displayed time shows you the real process time. 

 

 

 

 

 

The 3D-PDF Export functionality can alternatively be controlled via ERCL commands. The user then has 

the following ERCL commands. Find more detailed information in document "EASY-ROB-

ShortKeys_ENG.pdf" 

 
ERC _3D_PDF_EXPORT SCREENSHOT [flnname] 

ERC _3D_PDF_EXPORT ON / OFF [flnname] 

ERC _3D_PDF_EXPORT SET_FILE flnname 

ERC _3D_PDF_EXPORT SET_LABEL labelname 

ERC _3D_PDF_EXPORT SET_PASSWORD passwordname 

ERC _3D_PDF_EXPORT PAUSE 

ERC _3D_PDF_EXPORT DEACTIVATE 
 
Additional ERCL- commands allow to load a layout from a 3D-PDf Layout file ".3pl" or to determine the 
layout dynamically while running a program. 
 

! ------------------------------------------ 

! Date: 2016/09/14  Time: 10:43 

! 3D-PDF Version v7004 

! 3D-PDF Layout File "3D-PDF-Layout.3pl" 

! ------------------------------------------ 

! 

!(0,0)--> x  <-- width --> 

!  |        | 

!  v      height 

!  y        | 

! 

! Important Notes: 

! - Viewport-, Control-Area and all Images should be inside the Page-Area 

! - Images cannot be on top of the ViewPort- or the Control-Area, 

!   but can be used as background, if their size is less or equal to the Page-Area. 

! - The number of possible loaded images is limited by 12 

! - The "image path" and "image file" must be saved within quotes 

! ------------------------------------------ 

! 

! Page Area:  width height 

PAGE_AREA            400.000  300.000 

! 

! View Port Area: left(x) upper(y)  width height 

VIEWPORT_AREA        0.000  50.000  400.000  225.000 

! 

! Control Area: left(x) upper(y)  width height 

CONTROL_AREA         0.000  275.000  400.000  25.000 

! 

! Label Font Size: Default = 10, valid values are between 1 and 50 

LABELFONTSIZE        10 

! 

! Path where the images stored 

! If no path is defined, the current working directory is valid 

IMAGE_PATH           "" 

! 

! Images specifications for 3 images 

! Parameter 1:   "Image file name" 
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! Parameter 2-5: left(x) upper(y)  width height 

! Parameter 6:   Scaling is one of ISO_Stretch = 0 or ISO_CenterFit = 1 

ADD_IMAGE            "3D-Pdf-Image-Logo.jpg"  0.000  0.000  87.920  50.000  1 

ADD_IMAGE            "3D-PDF-IMAGE-TEXT.JPG"  87.920  0.000  312.080  50.000  1 

! 

 

 
 
 
ERC _3D_PDF_EXPORT RESET_LAYOUT 

ERC _3D_PDF_EXPORT LOAD_LAYOUT  filename.3pl 

ERC _3D_PDF_EXPORT SAVE_LAYOUT  filename.3pl 

ERC _3D_PDF_EXPORT PAGE_AREA  width height 

ERC _3D_PDF_EXPORT VIEWPORT_AREA left(x) upper(y)  width height 

ERC _3D_PDF_EXPORT CONTROL_AREA  left(x) upper(y)  width height 

ERC _3D_PDF_EXPORT LABEL_FONT_SIZE  valid values are between 1 and 50 

 
ERC _3D_PDF_EXPORT IMAGE_PATH  path 

ERC _3D_PDF_EXPORT IMAGE_PATH  USERPROFILE 

ERC _3D_PDF_EXPORT IMAGE_PATH  WORKING_DIRECTORY 

ERC _3D_PDF_EXPORT IMAGE_PATH  3PL_FILE_FOLDER 

ERC _3D_PDF_EXPORT IMAGE_PATH  "" 

ERC _3D_PDF_EXPORT ADD_IMAGE "filename.jpg" left(x) upper(y)  width height  scaling 

 
A detailed description of the commands can be found in the chapter “New ERCL-commands“ or in the 

corresponding document for the ERPL- / ERCL- Program language „EASY-ROB-ERPL_ENG.pdf“. 
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EASY-ROB™ Operation References 

Space Mouse 

Space Mouse Connection 
 

 
Navigation through 3D-Scene  with a 3D-Mouse (Space Mouse) from 3DConexion: 
The 3-dimensional navigation through the robot-complex is very intuitive and accurate 
 

  
 Picture: 3DConnexion 

 
Assignment of keys in your Space Explorer. 
 

 
1  Toggles  -> PanZoom  

 -> Rotate  
 -> Pan+Rotate 

 
2  Toggles  -> Cruise World  

 -> Jog cTcp  
 -> Jog cRobot Joints 

 
Shift as Keyboard 
Esc as Keyboard 
Ctrl  as Keyboard 
Alt  as Keyboard 
 

 

 
-   Reduces Sensitivity 
 
+   Increases Sensitivity 
 
 
T  Top View 
L  Left View 
2D  ohne Funktion 
R  Right View 
F  Front View 
 
 

 Panel Open Menu 
Fit  Zoom World, cRobot, cTag, .. 

 

 

 
TIP: Further settings can be made in the Environment-file „easy-rob.env“. 
 

! Activates/Deactivates Space Mouse Menu 
S3DM_MENU 1 
! Scales Space Mouse sensitivity 
S3DM_SPEED 1.000000 
! Scales Space Mouse threshold 
S3DM_THRESHOLD 1.000000 
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EASY-ROB™ Operation References 

Appendix 

Inverse / forward Kinematics ID’s 

 

 
The Inverse Kinematics ID defines the inverse kinematics and forward solution for each robot. EASY-ROB 
provides you with a couple of solutions for common robots like 3- or 5-axis, portalrobots, scaras, etc. 
 
For every Kin-ID exists a Sub-ID. 
 
You can edit the KIN-IDs and Sub-IDs in over Robotics Menu: 
 cRobot Kinematics -> Kinematics Data -> Inverse Kinematics ID -> Special Inverse Kinematics 

 

Kin-ID Name Sub ID Kin_Type Kommentar 

0    no inverse Kinematics available 

1 DLL #1   User-definied Kinematics in „er_kinx64.dll“ #1 

2 DLL #2   User-definied Kinematics in „er_kinx64.dll“ #2 

3 DLL #3   User-definied Kinematics in „er_kinx64.dll“ #3 

4 DLL #4   User-definied Kinematics in „er_kinx64.dll“ #4 

5 DLL #5   User-definied Kinematics in „er_kinx64.dll“ #5 

6 DLL #6   User-definied Kinematics in „er_kinx64.dll“ #6 

7 DLL #7   User-definied Kinematics in „er_kinx64.dll“ #7 

8 DLL #8   User-definied Kinematics in „er_kinx64.dll“ #8 

9 DLL #9   User-definied Kinematics in „er_kinx64.dll“ #9 

10 DLL #10   User-definied Kinematics in „er_kinx64.dll“ #10 

11 DLL #11   User-definied Kinematics in „er_kinx64.dll“ #11 

12 DLL #12   User-definied Kinematics in „er_kinx64.dll“ #12 

13-99 User Inverse 
Kinematics 

  User-definied Kinematics in „er_kinx64.dll“ #13-99 

100 NumSol 0  any serial Numerical Solution Kinematic >= 6  axis 
Further parameters: tolerances, joint weight, mask vector 

100 NumSol 1  any serial Numerical Solution Kinematic with less than 6 axis 
(in compliance with Approach-axis) 

140 NumSol-Ref  any serial Numerical Solution using reference kinematic 

110 articulated  RzRyy:Rxyx , 
RzRyy:Rzyz 

and Tracking-Axis 
„Standard  RRR:RRR on Y-Track“ 

111 articulated  RzRyy:Rxyx , 
RzRyy:Rzyz 

as 110, with „Backlink“ /. „A2A3 linking“ 
„Back Link RRR:RRR on Y-Track“ 

116 articulated   as 110, solution w.r.t Robot Base 

117 articulated   as 111, solution w.r.t Robot Base 

122 Güdel 0, 
10, 
11, 
12, 
13 

 RoboFlex (Jet Roboter) 
xyz- Gantry 
xyz:Rz Gantry 
xz or yz Gantry 
xyz:Rz, yxz:Rz Gantry 
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Inverse Kinematics ID 
 

Kin-ID Name Sub ID Kin_Type Kommentar 

120 b+m   T1 Paintingrobot 

123 Denso 0, 
1 

different types Standard  RRR:RRR on Y-Track 
Scara 4 axis RzRzTzRz 

124 Mitsubishi 0, 
1 

different types Standard  RRR:RRR on Y-Track 
Scara 4 axis RzRzTzRz 

125 Eisenmann 0,1,2, 
10 

different types vrbh6,vrbc6,vrbl5, 
E-Shuttle 

126 Adept 0, 
1 

different types Standard  RRR:RRR on Y-Track 
Scara 4 axis RzRzTzRz 

127 Jet Robot  TyRyy:Rxyx, 
TyRyy:Rzyz 

without „A2A3 coupling“ 

128 Jet Robot  TyRyy:Rxyx, 
TyRyy:Rzyz 

same as ID 127, but with „Backlink“/„A2A3 coupling“ 

129 Palletizer 0 
1 

RzRyyRz without Backlink 
with Backlink 

131 SCARA4 0  
1 
2 
3 

RzRzTzRz 
RzTzRzRz 
TzRzRzRz 
RzRzRzTz 

4 Axis Scara 

139 SCARA6 0 
1 
2 

RzRzTzRxzx 
RzTzRzRxzx 
TzRzRzRxzx 

6 Axis Scara 

     

133 Gantry 
2 Achsen 

13,23 Txz,Tyz, Tzx, 
Tzy, Txy, Tyx 

2 Axis Portal 

 Gantry 
3 Achsen 

123,0 Txyz,Tyxz,Tz
xy,Tzyx,Txzy,
Tyzx 

3 Axis Portal 

 Gantry 
1 Achse 

1,2,3 Tx, Ty, Tz 1 Axis Portal, Conveyor 

134 Gantry 
2+1 Achsen 

13, 23 Txz,Tyz, Tzx, 
Tzy, Txy, Tyx, 
Rz 

2 Axis Portal + Rz Rotary-Axis 

 Gantry 
3+1 Achsen 

123, 0 Txyz,Tyxz,Tz
xy,Tzyx,Txzy,
Tyzx, Rz 

3 Axis Portal + Rz Rotary-Axis 

135 Gantry,  
3+2 Achsen 

 Txyz,Tyxz,Tz
xy,Tzyx,Txzy,
Tyzx, 
CA=Rzx 

5-Axis Portal with C- und A-axis 

136 Gantry  
6 Achsen 

 Txyz,Tyxz,Tz
xy,Tzyx,Txzy,
Tyzx, 
Rzxz,Rzyz 

6-Axis Portal with Rzxz oder Rzyz Joint 

138 Comau  different types  

119 Reis  different types  
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Inverse Kinematics ID 
 
Optional Robot Libraries 
 

114 Abb  different types Option required 

118 Motoman  different types Option required 

115 Staubli  different types Option required 

112 Kuka  different types Option required 

113 Fanuc  different types Option required 

132 Tricept  Parallel kin Option required 

137 PKM  Parallel kin Option required, Delta-Kinematics, FlexPicker 
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EASY-ROB™  

 

Contact 
 

 
 

EASY-ROB Software GmbH 
 

Address:  Hauptstr. 42 

   65719 Hofheim am Taunus 

   Germany 

 

Contact:  Mr. Stefan Anton 

 

Phone:  +49 6192  921 70 77 

FAX:   +49 6192  921 70 66 

 

Email:   contact@easy-rob.com 

   sales@easy-rob.com 

 

Url:   www.easy-rob.com 

 

Online Shop: http://www.easy-rob.com/en/product/shop.html/ 

 

EASY-ROB customer area 
 
Content:  Program updates and robot libraries 

 
Web:   www.easy-rob.com/en/downloads-2/client-area/ 

 
Log in data: 
   User name: customer 

   Password: ********** 
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EASY-ROB™  

 

Notes 
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